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Глава 6

Квадратурная цифровая модуляция (/4-DQPSK
Простейший кодовый радиосигнал использует фазовую манипуляцию, т.е. скачкообразное изменение фазы сигнала, например, на 180(. Фазовый манипулятор BPSK (Binary Phase Signal Commutation) , реализующий такую модуляцию, управляется сигналом, который можно представить в виде последовательности значений по одному управляемому каналу и двух позиций фазы.

Четырехпозиционная, или квадратурная фазовая манипуляция (QPSK) используются в системах, в которых теоретическая спектральная эффективность модемов BPSK (1 бит/ Гц) недостаточна при имеющейся в наличие полосе частот. Различные методы демодуляции, используемые в системах BPSK, применяются также и в системах QPSK (квадратурная фазовая модуляция). Кроме прямого распространения методов двоичной модуляции на случай QPSK используется также 4-позиционная модуляция со сдвигом (смещением), обозначаемая как O-QPSK. При сдвиге на (/4 метод модуляции известен как (/4-DQPSK и принят в качестве стандарта американских и японских цифровых сотовых систем связи. 

В данной главе рассматриваются следующие вопросы:
-Mодификация системы QPSK, рассмотренной в главе 5, к системе (/4-DQPSK. 
-Использование уравнений в окне DDS для представления звездной и глазковой диаграммы.

6.1. Сигнальное созвездие для фазоманипулированного сигнала QPSK
Откроем проект  CommSys_Lab7_prj и схему проекта «a_QPSK_Sys».
В схеме рис. 6.1 поток данных сначала модулируется, а потом демодулируется как сигнал с модуляцией QPSK.
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Рис. 6.1. Схема, включающая входной поток данных, который через фильтр подается на модулятор QPSK, который анализировался в главе 5

Дважды нажмем на компоненту TkXYPlot, называемую «Filtered Constellation» (в элементе MOD QAM системы) и сделаем изменение установок (рис. 6.2)

 Style = connect
Выполним моделирование и выведем сигнальное созвездие на экран. Для этого изменим параметр Style на «connect».
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Рис. 6.2. Установка параметров интерактивного средства просмотра

Рассчитываемое сигнальное созвездие для сигнала QPSK (рис. 6.3) показывает, что в отдельные моменты времени траектория сигнала пересекает точку (0,0), когда происходит перескок на 180( между точками (1,1) к (-1,-1) или (1,-1) к (-1,1). 
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Рис. 6.3. Траектория сигнала QPSK на фазовой плоскости (I,Q)

Отметим, что сигнальное созвездие отражает то, что форма волны на выходе модулятора представляется выражением:

V(t)= I(t)*cos(c(t)+ref) -Q(t)*sin(c(t)+ref)

с модулем огибающей:
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Таким образом, мгновенная амплитуда огибающей  сигнала уменьшается до нуля, когда сигнал получает сдвиг на 180( по фазе. Это становится проблемой для нелинейного усилителя мощности с ограниченным динамическим диапазоном и может в результате привести к подъему спектра. Модуляция (/4-DQPSK решает эту проблему исключением резкого изменения фазы на 180(.

6.2. Сигнальное созвездие для фазовой модуляции 
(/4-DQPSK
Выполним следующие шаги для преобразования модулятора QPSK в более сложный модулятор (/4-DQPSK, используя времязависимые элементы.

Сохраним файл File> Save As… под именем «b_PI4DQPSK_Sys», и в этой новой схеме удалим компоненты TkPlot  с именем «Input Bits» и TkXYPlot с именем «Ideal Constellation».

Сдвинем источник Data и SymbolSplitter влево для создания некоторого пространства между SymbolSplitter и фильтрами.
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Рис. 6.4. Источник данных, декодер, который превращает расщепленный поток в поток с задержкой по одному каналу на (/4, фильтры, демодулятор и система вывода данных

Поместим компоненту декодера EncoderIQ (из библиотеки «Timed>Data Processing») между «SymbolSplitter» и фильтрами (рис. 6.6). Эта компонента (рис. 6.5) будет выполнять модуляцию по закону (/4-DQPSK. Установим следующие параметры этой компоненты:

SymbolTime = Sym_time  (единицы None)

Type = PI/4 DQPSK
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Рис. 6.5. Диалоговое окно установки параметров декодера IQ
Пояснение параметров этой компоненты декодера видно из табл. 6.1.

	Табл. 6. 1. Параметры модулятора EncoderIQ
E 1
	Величина
	Пояснение параметра

	RIn
	 50.0 Ohm
	Входное сопротивление

	ROut
	 50.0 Ohm
	Выходное сопротивление

	RTemp
	 - 2 7 3 . 1 5
	Температура 

	Symbol Time
	 Sym _ time
	Время между символами входных данных

	Delay
	 0.001 sec
	Время задержки от t=0 (начала интегрирования) и момента обнаружения входных данных, Delay = -1 для автосинхронизации

	Type
	 PI/4 DQPSK
	Тип декодирования IQ данных


Изменим параметр Persistance в TkXYPlot с именем «Filtered Constellation»:

Persistance = 6000
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Рис. 6.6. Подключение фильтров с характеристикой в виде приподнятого косинуса к декодеру

Отредактируем компоненту TkXYPlot с именем «Demodulated Constellation» так, что:

Style = connect
Persistence = 6000

Если теперь запустить моделирование и вывести звездную диаграмму (рис. 6.7) то видим, что она не проходит через точку (0,0) на диаграммах «Filtered Constellation» и «Demodulated Constellation».
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Рис. 6.7. Результат кодирования PI/4 DQPSK
Заметим, что сигнальное созвездие для кодированного сигнала (/4-DQPSK показывает, что траектория сигнала не проходит через точку (0,0). График «Filtered Constellation» показывает, что для сигнала (/4-DQPSK сигнальное созвездие состоит из двух графиков QPSK, которые сдвинуты на (/4 друг относительно друга (рис. 6.7). Поэтому есть минимальный фазовый сдвиг, который добавляет фазу на (/4 между каждым последовательным символом, который ограничивает максимальную фазу  135(, вместо 180( в QPSK. 
     Это сохраняет огибающую более постоянной, чем при модуляции QPSK и приводит к меньшему спектральному росту и лучшей величине ACPR (Adjust Conjugate Power Ratio), чем когда кодовая последовательность проходит через нелинейный усилитель мощности. Обратим внимание, что сигнальное созвездие демодулированного сигнала все еще кодируется, потому что демодулятор QPSK не удаляет кодирование, введенное кодером.

6.3. Рост спектра из-за нелинейности усилителя

     Поместим усилитель GainRF (из библиотеки «Timed Non-linear») между компонентами «SplitterRF» и «FFTAnalyzer» с именем «ModSpectrum» (рис. 6.8) и установим следующие его параметры:

Gain = 1 (усиление равное 1)

GCType = TOI
TOIout = +30 dBm – или напечатайте dbmtow(30).

Установим параметры спектроанализатора FFTAnalyzer «Mod_Spectrum», который включен на выходе усилителя

Instance Name = Mod_Spectrum_Comp

Window = Hanning

Скопируем компоненту FFTAnalyzer (с именем «Mod_Spectrum_Comp»)  и поместим новый анализатор на вход блока GainRF. Этот анализатор читает модулированный спектр перед усилителем, в котором он получит дополнительное искажение. Отредактируйте следующий параметр:

Instance Name = Mod_Spectrum

Выберем Simulate>Setup… и дадим имя набору данных «Encoded».  Выполним моделирование и выведем оба спектра («Mod_Spectrum» и «Mod_Spectrum_Comp») в окно  «Rectangular Plot» (рис. 6.8, a,b).

 
Установим шкалу диапазона 100 dB, верхнее значение 0 dB и шкалу 10 dB/div.
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Рис.6.8.a) Установка компоненты спектроанализатора на выходе схемы

Тип учета нелинейности, или тип сжатия усиления (GCType) устанавливается как интермодуляционные искажения 3-го порядка, так что учитывается только параметр TOI (точка пересечения).
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Рис. 6.8 b). Искажение спектра сигналов QPSK и  PI/4 DQPS в одинаковом усилителе

Заметим влияние сжатия усиления на боковые лепестки спектра. Они примерно на 10 dB увеличивают уровень спектра.
     Дважды кликнем на “EncoderIQ” и изменим тип декодера на “Uncoded”.

Параметры спектроанализатора на рис. 6.7 a) поясняются в табл. 6.2.

Табл. 6. 2. Параметры компоненты спектроанализатора FFTAnalyzer
	Mod_Spectrum
	Величина
	Если моделирование установлено для открытия данных после моделирования и если Plot не установлен на 'None', тогда данные заносятся в сборник данных

	Start
	 D F _ V a l u e


	Начальное время для записи данных

	Stop 
	 D F _ V a l u e


	По умолчанию TimeStop

	Display Freq Unit
	 M H z

	Единицы частот

	NPoints
	 1 0 2 4


	Число точек на сегмент – должно быть числом степени 2

	NAverage
	 1


	Число точек, используемых в окне сглаживания

	Param 
	 0 . 5


	Параметр окна

	W i n d o w
	 H A N N I N G
	Тип выделение в окно, окно Гамминга или др.

	NSegments
	 1


	Число используемых сегментов

	Overlap
	 0


	Коэффициент перекрытия (количество точек между двумя смежными сегментами)

	Bias
	 BIAS_POWER
	Тип смещения для нормализации спектра

	D i s p l a y
	 dBm

	Показ спектра в dBV, или в dBm

	Ref _ Resistance
	 50.0


	Опорная нагрузка для расчета в  dBm, в Омах


     Нелинейный усилитель GainRF описывается как блок с заданным входным и выходным сопротивлением, усилением и точкой пересечения третьего порядка, определяемой координатой точки пересечения а) зависимости линейного усиления и b) экстраполированной из малосигнальной области интермодуляционных продуктов третьего порядка (табл. 6.3).

Табл. 6. 3. Параметры нелинейного усилителя G a i n R F
	G 8
	Величина
	Пояснения

	RIn
	 5 0 . 0 O h m
	Входное сопротивление

	ROut
	 5 0 . 0 O h m
	Выходное сопротивление

	
	
	Физическая температура, в градусах C

	Gain
	 1
	Усиление по напряжению; в форме re+j*im; для задания усиления в  dB используйте функцию dbpolar( dB, degree)

	G C T y p e
	 T O I
	Точка сжатия усиления

	T O I o u t
	 d b m t o w ( 3 0 ) 
	Точка пересечения третьего порядка по мощности


Кликнем “Simulate>Setup…” и изменим имя набора данных на “Uncoded”.

Выполним моделирование и поместим графики дополнительно кодированного и дополнительно некодированного сжатого спектра в окно DDS. Убедимся в различии  между (/4 -DQPSK (кодированного) спектра и QPSK (некодированного) спектра.
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Рис.6.9. Спектр сигнала, модулированного (/4 –DQPSK и сигнала QPSK

Переходной процесс между состояниями в сигнальным созвездии QPSK проходит начало координат. Это означает, что амплитуда ВЧ сигнала проходит нулевое значение. Это делает нелинейность усилителя «более значимой» для этого сигнала, чем для сигнала PI4DQPSK, который не пересекает начало координат.

Рост спектра - это функция нелинейных характеристик усилителя. В этом простом примере нелинейные характеристики усилителя описываются только выходной точкой пересечения TOI. Более сложная модель может моделироваться используя метод огибающей для реальной схемы усилителя мощности.

Отметим, что дифференциальное кодирование дает преимущество в росте спектра для проектируемого усилителя, но какая цена этому?

Для ответа на этот вопрос, исследуйте сигнальное созвездие кодированного сигнала, и рассмотрите зависимость BER от фазового шума.

Сохраним кодирование в «PI4DQPSK».

Удалим компоненты «Mod_Spectrum_Comp» FFTAnalyzer  и компоненту GainRF. Сохраним нагрузку 50 ом для компоненты SplitterRF.

6.4. Демодулятор Pi4DQPSK
6.4.1. Библиотечная модель демодулятора (/4-DQPSK
Демодулятор (/4-DQPSK будет загружен из библиотеки. Его модель будет модифицирована (в следующем параграфе) для создания собственной компоненты для демодулятора.

Удалим источник «N_Tones» и элемент «QPSK_Demod».

Из библиотеки «Timed Modem» выберем некогерентный дифференциальный демодулятор (/4-DQPSK с именем “DQPSK_Pi4Demod” (рис. 6.10).
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Рис.6.10. Выбор из библиотеки модели некогерентного дифференциального демодулятора QPSK
Установим следующие параметры этого демодулятора (рис. 6.11):

RefFreq = IF_freq,  единицы   None

SymbolTime = Sym_time,  единицы  None

ExcessBW = 0.35
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Рис. 6.11. Установка параметров некогерентного (/4-DQPSK демодулятора
Соединим демодулятор «DQPSK_PI4Demod» (его параметры раскрываются в табл. 6.4) с выходом «SplitterRF» за «QAM_Mod».

Удалим компоненту «TkXYPlots» и все элементы справа, требуемые для выделения выборок сигнала  (Clocks, SampleAndHolds, SplitterRFs, etc). Вместо этого мы будем использовать функции, которые можно использовать в окне вывода данных для вывода сигнального созвездия и глазковой диаграммы.

Удалим компоненту TkPlot с именем «Eye Diagram».

Присоединим TimedSink с именем «Iout» и «Qout» к выходу «DQPSK_PI4Demod» (рис. 6.12).
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Рис. 6.12. Выходная часть вывода характеристик демодулированного сигнала 

Табл. 6.4. Параметры демодулятора DQPSK_Pi4Demod
	D 2
	Величина
	Пояснения

	RIn
	 50.0 Ohm
	Входное сопротивление

	ROut
	 50.0 Ohm
	Выходное сопротивление

	RTemp
	 - 273.15
	Физическая тампература

	Ref Freq
	 IF _ freq
	Опорная ПЧ частота

	Symbol Time
	 Sym_time
	Входной интервал символьного времени

	Excess Bw
	 0 . 3 5
	Коэффициент увеличения ширины полосы косинусного фильтра


Одно из главных преимуществ системы модуляции (/4-DQPSK состоит в том, что сигнал в ней так раздельно закодирован, что информация (фаза, состояние) каждого последующего символа устанавливается относительно предыдущего символа.

Поэтому демодулятор, который может модулировать несущую по разности или абсолютной фазе, больше не требуется для демодуляции. Это устраняет потребность в схеме восстановления несущей и упрощает процесс демодуляции.

Отредактируем параметр компоненты «QAM_Mod»:

Power = +14.5 dBm,  или напечатайте dbmtow(14.5)

Эта мощность требуется для получения амплитуды символов ( 1V на выходе дифференциального демодулятора (/4-DQPSK (рис. 6.13).
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Рис. 6.13. Диалоговое окно установки параметров квадратичного амплитудного модулятора

Окончательно схема преобразования данных должна выглядеть следующим образом:
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Рис. 6.14. Схема в окне DSP расчета временных потоков I и Q
6.4.2 Создание новой модели демодулятора (/4-DQPSK
     Модифицируем модель из библиотеки для создания собственного демодулятора. Затем занесем ее в библиотеку проекта и загрузим в проект, заменяя демодулятор (рис. 6.15)  из библиотеки ADS.

     Выполним команду Push для компоненты «DQPSK_PI4Demod», переходя по иерархии к ее внутренней схеме.
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Рис. 6.15. Схема демодулятора, состоящего из DSP компонентов

Отредактируем параметры компоненты «BPF_RaisedCosineTimed»:

Delay = 8*SymbolTime – единицы установим на  None
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Рис. 6.16. Символ и параметры фильтра с характеристикой в виде приподнятого косинуса

Выберем File> Save As… и сохраним модифицированный проект под именем «c_new_DQPSK_Pi4Demod».

Выберем File> Design/Parameters… и изменим:

Description = c_new_DQPSK_Pi4Demod

Кликнем на «SaveAELfile» внизу диалога и затем OK (рис. 6.17).

      Заметим, что имя библиотеки  *. Оно может быть переписано для отражения имени библиотеки пользователя «Custom Elements» или в какой-нибудь другой категории.

     Сохраним проект, названный теперь «c_new_DQPSK_PI4Demod».

     Вернемся к проекту «b_Pi4DQPSK_Sys» из списка проектов внизу.
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Рис. 6.17. Задание параметров проекта нового демодулятора

6.4.3. Замена библиотечной модели новой моделью демодулятора (/4-DQPSK 

Исходный демодулятор будет заменен новым проектом, который обеспечит большую точность моделирования из-за увеличения задержки фильтра. 

Кликнем «DQPSK_Pi4Demod» и выберем Edit> Component> Swap Components из меню.

Кликнем кнопку «Select ...»  чтобы вызвать браузер библиотеки.

Выберем «Sub-networks» CommSys_Lab7_prj(DSP) в столбце  «Libraries»

Выберем  «c_new_DQPSK_Pi4Demod» в столбце «Components».

Кликнем на кнопку  «Edit Parameters…» в окне  «Swap Components» и отредактируем параметры (рис. 6.18) следующим образом:

RefFreq = IF_freq , 

единицы None

SymbolTime = Sym_time ,  
единицы None

ExcessBw = 0.35

Кликнем OK в окне «Edit Component Parameters» и в окне «Swap

Components». Этим в схему устанавливается новая компонента.
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Рис. 6.18. Символ и параметры демодулятора

Отредактируем параметры контроллера потока данных , DF1 (рис. 6.19):

OutVar = Bit_rate Sam_per_sym
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Рис. 6.19. Символ и параметры компоненты потока данных

Сохраним проект и выполним моделирование с именем данных  «PI4DQPSK_Sys» (изменим имя данных при установке  «Simulation>Setup…»).

6.5. Сигнальное созвездие в окне вывода данных

6.5.1. Функция расчета звездной диаграммы «constellation»:

Чтобы получить сигнальное созвездие, в данном случае используем функцию «constellation» в окне вывода данных:

constellation ( I , Q , symbol rate , delay ).

Эта функция имеет 4 параметра.

Первые два параметра, I и Q, представляют данные сигналов во временной области для I и Q каналов.  В проекте они зафиксированы, используя установленные сборники.
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Рис. 6.20. Временные зависимости модулей комплексных сигналов I и Q
Третий параметр symbol rate - вещественное число, представляющее символьную скорость. Четвертый параметр delay - также вещественное число, представляющее задержку для осуществления  выборки при изображении сигнального созвездия.

       Задержка для выборки сильно влияет на вид сигнального созвездия, что также приводит к сильному влиянию на BER. Пример того, как момент выборки влияет на диаграмму, будет показан в этой главе.

6.5.2. Применение функции «constellation»

     После того, как моделирование завершено, откроем окно вывода данных. Введем в поле вывода данных следующие уравнения:
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Функция «mag» используется для выделение модулей «Bit_rate» и «Sam_per_sym». Отметим, что на выходе ADS эти числа комплексные величины (с мнимой частью равной нулю). Тип каждой переменной может быть проверен, используя кнопку «Variables Info…», имеющуюся в окне редактирования уравнений, или используя функцию «what»  в окне данных в «List».

Использование функции «mag» в этом случае необходимо потому, что функция «constellation» ожидает реальные числа для скорости передачи символов и задержки.

Введем в поле окна вывода данных уравнение, рассчитывающее задержку выборок для сигнального созвездия:

[image: image24.wmf]Eqn
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Коэффициенты 18.5 и 0.5 в этом уравнении указывают на следующее:

- 16 длительностей символов из фильтра с приподнятым косинусом в модуляторе и демодуляторе (8 символов в каждом)

- плюс дополнительные 2 символа временной задержки из-за первых двух символов вне (поскольку это дифференциальное кодирование)

- плюс задержка на половину символа 0.5 для начала выборки в середине символа

- минус половина временного шага (0.5( time step) для коррекции времени передачи от одного символа к другому; это переносит начальный момент выборки точно в середину символа.

Введем уравнение для вывода графика сигнального созвездия:

[image: image25.wmf]Eqn
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      Сигналы Iout и Qout это есть символы I и Q, на выходе демодулятора, заносимые с помощью компоненты TimedSinks.

      После того, как уравнение написано корректно, введем прямоугольный график (рис. 6.21). Когда появляется диалог, выберем в списке параметр «Equations» и дадим ему значение «Const».
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Рис. 6.21. Сигнальное созвездие, выводимое в окно данных

6.6. Глазковая диаграмма в окне вывода данных

6.6.1. Функция «eye»:

Функция с именем «eye» используется, чтобы обработать информацию в наборе данных и получить глазковую диаграмму:

eye ( data , symbol rate , number of cycles , delay )

Функция имеет 4 параметра.

data -данные для сигнала области времени, который используется для глазковой диаграммы. Это - I или Q сигналы, зафиксированные в проекте, используя установленный приемник данных.

symbol rate – cимвольная скорость.

number of cycles – число циклов, которое используется в нанесении глазковой диаграммы.

delay – время запаздывания для привязки по времени в глазковой диаграмме. Это задержка может использоваться, чтобы «выровнять по центру» открытие глаза в диаграмме.

Эта функция строит новую переменную, которая переносит данные, начинающиеся с начала сбора данных в установленных сборниках данных. Процесс переноса определен числом периодов циклов. Используйте кнопку «Variable Info …» в окне редактирования уравнения, или функцию «what» для вывода графика зависимости этой новой переменной.

Обратите внимание, что аргумент «delay» не влияет на начало процесса визуализации. Он управляет только положением точки time=0. Итак, этот параметр может не использоваться для исключения визуализации переходных процессов в начале процесса демодуляции. 
      Индексация вектора «eye» необходима, чтобы устранить переходные процессы на глазковой диаграмме. Пример того, как это может быть достигнуто, будет показано позже.

6.6.2. Использование функции “eye”

Внесем уравнения в поле Display уравнения:
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Внесем также уравнение для создания глазковой диаграммы
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Iout - это поток символов I, идущий от демодулятора, и заносимый в компоненту TimedSink.

Выведем на график величину eye_diagram  (рис. 6.22):
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Рис. 6.22. Глазковая диаграмма, с учетом начального процесса

        Сравним эту диаграмму с графиком во временной области, выведенном в виде данных I data. Заметим, что глазковая диаграмма имеет начальный переходной процесс в процессе демодуляции (рис. 6.23).
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Рис. 6.23. Начальный процесс Iout с учетом задержки

Изменим число циклов (величину «eye_cycles»), как показано на рис. 6.24 и увидим, как оно влияет на глазковую диаграмму.
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Рис. 6.24. Глазковые диаграммы с различными количествами циклов

Изменим задержку  (величину «delay_eye»), что показывается стрелкой на рис. 6.25 и увидим, как изменилась глазковая диаграмма. 
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Рис. 6. 25. Глазковые диаграммы с различными задержками delay_eye
6.7. Важность момента точки выборки
 в процессе демодуляции

      Поместим маркер «m1» на глазковую диаграмму и сдвинем его как можно ближе к центру открытого глаза, в котором должна быть идеальная точка выборки (рис. 6.26). 
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Рис. 6. 26. Экран вывода данных Display Data
      Покажем, как выполняется синхронизация осуществления выборки. Считается, что этот момент выборки  совпадает с серединой символа, 0.5*symbol_time. Это не нужно для коррекции 0.5*Tstep, как отмечено ранее в этом примере.

      Сигнальное созвездие, сформированное с осуществлением выборки сигнала в этот момент будет соответствовать рис. 6. 26.
Обратите внимание на расплывание точек. Это расплывание показывает, что оно было сгенерировано в неправильный момент осуществления выборки.

Чтобы исправить этот эффект, выборки нужно выполнять, когда глазковая диаграмма имеет наибольшее открытие (все кривые сходятся в одной точке).

      Поместим второй маркер, «m2», на графике глазковой диаграммы и переместите его как можно ближе к центру открытия глаза, но с другой стороны по отношению к «m1».

      Вычислим расстояние между этими двумя маркерами. Это расстояние будет равно time_step, что является ожидаемым результатом. Это доказывает, что момент выборки нужно скорректировать на величину половины временного шага по сравнению с центром символа. 

6.8. Исключение начального переходного процесса

       Глазковая диаграмма, рассчитанная с помощью функции, непосредственно не устраняет начальные переходные процессы, поскольку невозможно заранее определить длительность этих переходных процессов. Синхронизация изменяется из проекта в проект, так что это надо делать осторожно.

      Есть несколько способов исключить визуализацию этих начальных переходных процессов. Возможности, которые используются в этом процессе, связаны с методами управления индексов.

Один из таких способов состоит в том, чтобы использовать функции «int» и «sweep_size», “::”, управляющиеся индексами (рис. 6.27).

Используем кнопку «Variables Info…» в окне редактирования уравнений, для понимания процесса управления индексации данных.
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Рис. 6. 27. На данном графике момент выборки – идеальный

      Итак, в данной главе система QPSK, рассмотренная  в главе 5 была преобразована в систему (/4 -DQPSK.

      Преимущества модуляции (/4 -DQPSK перед квадратичной фазовой модуляцией QPSK были показаны на примере роста спектра в нелинейном усилителе: более сложная модуляция дает меньшие искажения.

      Проект демодулятора изменялся, чтобы обеспечить большую точность, увеличивая задержку фильтров.

      Чтобы сохранить I и Q символы, использовались сборники данных и постобрабатывающие функции в окне DD, чтобы отображать сигнальное созвездие и глазковую диаграмму.

       В примере использованы функции «constellation» и «eye» для вывода сигнального созвездия и глазковой диаграммы на дисплей данных.

Влияние момента выборки на процесс демодуляции был кратко проанализирован с использованием глазковой диаграммы и сигнального созвездия.

       Наконец, был показан метод подавления начальных переходных процессов демодуляции из глазковой диаграммы.

Итак, в этой главе продемонстрированы основные приемы исследования, с помощью Ptolemy, цифровой модуляции/демодуляции в системах связи.
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